UNIVERSITY OF

EXETER

How to set up Email Forwarding and Out Of Office

This guide details how to set up Out of Office automatic replies and Forwarding rules for your University
of Exeter email.

There are separate sections for setting these in Office365 email or in the Qutlook client if you use that.

If you need any further assistance please contact the SID desk

0365 - Out Of Office

1. Inyour O365 emaill, click on the cogwheel to open the Settings menu then click on “Automatic
replies”

=2 Office 365 Outlook
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Display settings
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Offline settings
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2. This will open the “Automatic replies” page in the Options menu where you can enter the start and
end dates and times for when you want automatic replies to be sent to University colleagues who

email you while you are away.

= save X DISCARD

Automatic replies

Create automatic reply (Out of Office) messages here. You can set your reply to start at a specific time, or set it to continue until you turn it off,

(O Don't send automatic replies
®) Send automatic replies
Send replies only during this time period

Start time
Wed 11/03/2015 - 530PM -

End time

Mon 16/03/2015 - 8:00 AM =

Send a reply once to each sender inside my organization with the following message:

Calibri |12 | B I U | ¥

I'm away for Thursday & Friday. | will reply to your email when |
return on Monday.

thanks
Andy

3. You can choose whether you want people outside the University to get an automatic reply too, and
you can send the same or a different reply to them at the bottom of the page. You can limit these
external replies to your existing email Contacts only or all external senders.

Send automatic reply messages to senders outside my organization
£ - -
() Send replies only to senders in my Contacts list

(®) Send automatic replies to all external senders
Send a reply once to each sender outside my crganization with the following message:

Calibri v (|12 - B I H B ¥

I'm away for Thursday & Friday. | will reply to your email when |

return on Monday.

thanks
Andy

4. Click on the | = s4VE |button at the top of the page to save and activate the Out Of Office rule.

5. It's a good idea to send yourself (or ask a colleague to send) a test email to check that your Out Of

Office rule is working ok.



0365 — Email Forwarding

1.

2.

In your O365 email, click on the cogwheel to open the Settings menu then click on “Options’

Under the “Accounts” menu at the left of the page, click on “Forwarding
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3. Onthe Forwarding page, click the radio button to Start Forwarding.

= sAvE ¥ DISCARD

Forwarding

@ Start forwarding

Forward my email to:

» Error: A wvalid email address is required to start forwarding your messages.
|:| Keep a copy of forwarded messages in Qutlock on the web

() Stop forwarding

4. Enter the email address to which you want to forward your university emails

H save ¥ DISCARD

Forwarding

@ Start forwarding

Forward my email to:

joesmith@hotmail.co.uk *

|:| Keep a copy of forwarded messages in Outlook on the web

O Stop forwarding

5. If you want to keep all forwarded emails in your uni email account as well, tick the checkbox as
shown:

H save % DISCARD

Forwarding

® Start forwarding

Forward my email to:

joesmith@hotmail.co.uk

Keep a copy of forwarded messages in Qutlock on the web

)

(O Stop forwarding

6. Click “Save” at the top of the page to activate your email forwarding.



Outlook — Out Of Office

1. Inyour Outlook email client, navigate to the ‘File’ tab, then under the ‘Info’ page, click on the
‘Automatic Replies’ button

‘w Home Send / Receive Folder View

&} save As .
Account Information
i=¥ | €Al
— ca A.Spedding@exeter.ac.uk =
Info :< ¥ Microsoft Exchange
&P Add Account

Open
Print — Account Settings

'fa-‘;Ll Modify settings for this account, and configure
Help L additional connections.

;\itc.ount Access this account on the web.,

] Options S ethings & https://outlook.office365.com/...ter.ac.uk/

Y Exit

Automatic Replies (Out of Office)
ii; Use automatic replies to notify others that you are out of office, on

vacation, or not available to respond to e-mail messages.
Automatic Ik
Replies
— Mailbox Cleanup
ul)
= Manage the size of your mailbox by emptying Deleted Items and
archiving.
Cleanup 5] ‘
Tools ~ ‘ ‘
= ~ 47.4 GB free of 49.5 GB
Rules and Alerts
7 4{;’ Use Rules and Alerts to help organize your incoming e-mail
= messages, and receive updates when items are added, changed, or
Manage Rules removed.

& Alerts




2. This will show a dialogue box where you can enter the start and end dates and times for when you
want automatic replies to be sent to University colleagues who email you while you are away.

Automatic Replies - ASpedding@exeterac.uk l&]

(7 Do not send automatic replies
@ Send automatic replies
Only send during this time range:
Starttme: |Wed 11/03/2015 [+| 17230 [ =]

End time:  |Mon 16/03/2015 [=| 0300 [ =]

Automatically reply once for each sender with the following messages:

T . .
& Inside My Organization e, Outside My Organization (0n)

Calibri »|12 [+| B r U Az iz EE

I'm away for Thursday & Friday. | will reply to your email when | return on
Monday.

thanks

Andy

o] (o

3. You can choose whether you want people outside the University to get an automatic reply too, and
you can send the same or a different reply to them on the second tab “Outside My Organization”.
You can limit these external replies to your existing email “My Contacts only” or “Anyone”

% Inside My Crganization e, Cutside My Qrganization {On)

Iﬂ.ﬁ.um +eply to people outside my organization

(7)1 My Contacts only @) Anyone outside my organization

Calibri »|12 [+ B 5 U Az iZEE

I'm away for Thursday & Friday. | will reply to your email when | return on
Maonday.

thanks

Andy

4. Click on OK to save and activate the Out Of Office rule.

5. It's a good idea to send yourself (or ask a colleague to send) a test email to check that your Out Of

Office rule is working ok.



Outlook — Email Forwarding

1. Inyour Outlook email client, navigate to the ‘File’ tab, then under the ‘Info’ page, click on ‘Rules
and Alerts’

‘w Home Send / Receive Folder View

@ Save As .
W Account Information
=¥ L I
— .+, ASpedding@exeter.ac.uk
Info :< ¥ Microsoft Exchange
gp Add Account
Open =
Print _— Account Settings
1:;“' Modify settings for this account, and configure
Help i additional connections.
;xcttc_ount Access this account on the web,
] Options Cl ! https://outlook.office365.com/...ter.ac.uk/
Exit

Automatic Replies (Out of Office)

ﬁ.l Use automatic replies to notify others that you are out of office, on
. vacation, or not available to respond to e-mail messages.

Automatic
Replies
- Mailbox Cleanup
ull
r_-_?j Manage the size of your mailbox by emptying Deleted Items and
archiving,
Cleanup i ‘
Tools - H ‘
= = 47.4 GB free of 49.5 GB
Rules and Alerts
L_ﬁ‘} Use Rules and Alerts to help organize your incoming e-mail
. messages, and receive updates when items are added, changed, or
Manage Rules removed.

& Alerts
N




2. This will open the “Rules and Alerts” dialogue box

-
Rules and Alerts

E-mail Rules | Manage Alerts

Apply changes to this folder:

Inbox [A.Spedding@exeter.ac.uk]

@ New Rule... Change Rule » 53 Copy... X Delete

& % Run Rules Now... Options

| Rule (applied in the arder shawn) | Actions | -
Lync users 3 P
OFFICE365-MANAGERS @IISCMAIL. AC.UK 23 by

Rule description (dick an underlined value to edit):
Apply this rule after the message arrives
withiLync loginin the subject
move it to the Lync users folder

and stop processing more rules

Enable rules on all messages downloaded from RS5 Feeds

[ Ok ][ Cancel ][ Apply ]

Click on the “New Rule” button | [ new Rule. ..

3. This will then show The Rules Wizard dialogue box

-
Rules Wizard

=

Start from a template or from a blank rule
Step 1t Select 3 template
Stay Organized
-.E} Mave messages from someone to a folder
ﬂ Move messages with specific words in the subject to a folder
I-E Move messages sent to a public group to a folder
Y Flag messages from someone for follow-up
n.Ei Mave Microsoft InfoPath forms of a spedific type to a folder
LE} Mave RSS items from a spedific RSS Feed to a folder
Stay Up to Date
. Display mail from someone in the New Item Alert Window
Wfl Play a sound when I get messages from someone

E Send an alert to my mobile device when I get messages from someone
Start from a blank rule

1 Apply rule on messages I receive .
=1 Apply rule on messages I send by

Step 2: Edit the rule description (dick an underlined value)
Apply this rule after the message arrives

< Back [ Mext = ] [

Fiish |

4.

In the “Start from a blank rule” section, highlight “Apply rule on messages | receive” then click
“Next”.



5. Tick the “where my name is in the To or Cc box” option, then click “Next”.

-
Rules Wizard u

Which condition(z) do you want to ched:?
Step 1: Select condition(s)

[] from people or public group
[] with specific words in the subject b
[] through the specified account

[] sentonly to me

[] where my name is in the To box

[] marked as importance

[] marked as sensitivity

[] flagged for action

[] where my name is in the Cc box

‘where my name is in the To or Cc box

[] where my name is not in the To box

[] sent to people or public group

[] with specific words in the body

[] with specific words in the subject or body
[] with specific words in the message header
[] with specific words in the redipient's address
[] with specific words in the sender's address
[] assigned to cateqory categary &7

»

m

Step 2: Edit the rule description (dick an underlined value)

Apply this rule after the message arrives
where my name is in the To or Cc box

6. Tick the “forward it to people” option then click “Next”.

-

Rules Wizard M

What do you want to do with the message?
Step 1: Select action(s)

[[] move it to the spedified folder
[] assign it to the cateqory category b
[] delete it

["] permanently delete it

[[] move a copy to the specified folder

forward it to people or public aroup

orward it to people or public group as an attachment
[] redirect it to people or public group

["] have server reply using a specific message

[] reply using a specific template

[[] flag message for follow up at this time

["] dear the Message Flag

[7] dear message's cateqaries

[] mark it as importance

[] print it

[ play a sound

[] start application

[] mark it as read -

»

m

Step 2: Edit the rule description (dick an underlined value)

Apply this rule after the message arrives
where my name is in the To or Cc box

forward it to people or public aroup

Cancel | | <Back || next> | [ Finish




Tick the “forward it to people” option then click on the underlined “people or public group” in the
“Step 2: Edit the rule description” box.

If you don’t do this you'll get the error message

7 e TR | B i i
Microsoft Outiook Ld w

o A value in the 'Rule description’ box was not set,
/'_I'«_X To set a value, dick underlined words in the Rule description area.

This will display the “Rule Address” dialogue box

i S ¢ S — - :
Rule Address - — w
Search: @ Nameonly ( More columns  Address Book
: || Go | Global Address List - A.Spedding@exeter.ac.t v Advanced Find
l Name Title Business Phone Location I
» , Magdalena Peninsula College #N
& ., Rezafaraby The Law School ||
& ., Susiati Graduate School o
& ., Vishal Management
& 1, Card Not Known CLES Visitor Exete
& 1, Visitor Not Known Exeter Assodate
& 1914FACES2014conference
& 2, Card Not Known CLES Visitor Exete
& 2, Visitor Not Known Exeter Assodate
& 21st Century Celts Conference E... School of Humaniti
& 3, Card Not Known CLES Visitor Exete
& 3, Visitor Not Known Exeter Assodate
& 4, Card Not Known CLES Visitor Exete
& 4, Visitor Not Known Exeter Assodate
& 6, Card Not Known CLES Visitor Exete
& 7, Card Not Known CLES Visitor Exete _
A A A DhAC
4| 1 ?
‘andy.spedding@hotmail.co.uk]
[ o Q | cancel |

_ 4
In the “To ->” box, enter the email address you want your University emails to be forwarded to.

Alternatively, you can choose an address from the Global Address List or your Contacts by opening
the “Address Book” dropdown at top right.

Click “OK” to save the forwarding email address in the “Step 2: rule description” box, then click
“Next”.



8. You then have the option to tick any of the Exception conditions if required. Click “Next” to continue.

-
Rules Wizard u

Are there any exceptions?
Step 1: Select exception(s) (if necessary)

[ |iexcept if from people or public group

[] except if the subject contains specific words
[] except through the spedified account

[] except if sent only to me

[7] except where my name is in the To box

[] except ifit is marked as impaortance

[] except ifitis marked as sensitivity

[] exceptifitis flagged for action

[] except where my name is in the Cc box

[] except if my name is in the To or Cc box

[] except where my name is not in the To box =
[] except if sent to people or public aroup

[] except if the body contains specific words

[] except if the subject or body contains specific words

[] except if the message header contains specific words

[] except with specific words in the recipient's address

[] except with specific words in the sender's address

[] except if assigned to category category A

»

m

Step 2: Edit the rule description (dick an underlined value)

Apply this rule after the message arrives
where my name is in the To or Cc box
forward it to andy.spedding@hotmail. co.uk

Cancel l[ < Back ][ Mext = ][ Finish

9. The last step is to give this rule a meaningful name, and select when you want the rule to run.

-
Rules Wizard M

Finish rule setup.

Step 1: Specify a name for this rule

Forward uni emails to home|

Step 2: Setup rule options
[~ Run this rule now on messages already in "Inbox™
Turn on this rule

[ create this rule on all accounts

Step 3: Review rule description (dick an underlined value to edit)

Apply this rule after the message arrives
where my name is in the To or Cc box
forward it to andy.spedding@hotmail. co.uk

Cancel l [ < Back Next =

Click “Finish” to save and activate your email forwarding.



